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UNIT-IV 

What is PowerPoint?  

 PowerPoint is a graphical presentation program used to organize and present 

information.  

 Powerpoint  is a presentation program developed by Microsoft.it was released on 

April 20,1987.  

 PowerPoint presentations consist of a number of individual pages or  "slides.”  

 To convey a message or a story, you break it down into slides. 

 Slides may contain text, graphics, sound, movies, and other objects that can be  freely 

arranged.  

 The software  allows users to create anything from basic slide shows to Complex 

Presentation. 

 It is used to create business presentation and also educational  purposes.  

What is an Effective Presentation? 

 An Effective presentation makes the best use of the relationship between the 

presenter and the audience. 

 It takes full consideration of the audience’s needs in order to capture their 

interest, develop their understanding,inspire their confidence and achieve the 

presenters objectives.  

Features of MS Powerpoint 

 

 Customize color schemes. 

 Add Animation Effects. 

 Use the Slide, Notes and Handout Masters. 

 Create,Edit and Import Charts. 

 Manage Hyperlinks. 

 Create Custom Shows. 

 Export Outlines & Presentation Slides to Word.  

The Powerpoint Ribbon is the User Interface. 

 The Ribbon Consists of tabs that group tools and features. 

 In Power point the Ribbon which is called Tabs,that runs across the top of the 
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powerpoint window. 

 From the Ribbon, you’ll access everything the program has to offer 

Creating New Presentations  

The New selection gives you several options:  

 Blank presentation creates a new presentation using default settings for text 

and  color. Theses slides will not include content or design elements.  

 Templates and Themes are used to create a new presentation based on pre‐  
designed slide styles. These options also do not include content.  

 New from existing will use the formatting of a previously created 

presentation.  

 we’ll start with a Blank presentation. Select New, choose Blank  presentation 

and click on the Create icon.  

 

You can change the template and theme of the presentation   

 

When You Open Power Point  
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When You Open Power Point  

By default Power Point opens a blank project. You can change the 

presentation templates by clicking “New” from the menu pops from 

the Office Button 

Step 1: Click the Start button. 
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Step 2: Click All Programs option from the menu. 

 

Step 3: Search for Microsoft Office from the sub menu and click it. 
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Step 4: Search for Microsoft PowerPoint 2010 from the submenu and click it. 

 

 

This will launch the Microsoft PowerPoint 2010 application and you will see the following 

presentation window. 
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   POWERPOINT   EXPLORING WINDOW 

 

 

The following screenshot shows the various areas in a standard PowerPoint file.  

It is important to familiarize yourself with these areas as it makes learning and using 

PowerPoint easier. 
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File Tab 

This tab opens the Backstage view which basically allows you to manage the file and settings 

in PowerPoint. You can save presentations, open existing ones and create new presentations 

based on blank or predefined templates. The other file related operations can also be executed 

from this view. 

 

Ribbon 

The ribbon contains three components: 

 Tabs: They appear across the top of the Ribbon and contain groups of related 

commands. Home, Insert, Page Layout are examples of ribbon tabs. 

 Groups: They organize related commands; each group name appears below the group 

on the Ribbon. For example, a group of commands related to fonts or a group of 

commands related to alignment, etc. 

 Commands: Commands appear within each group as mentioned above. 

 

 

When You Open Power Point 

 Power Point menu and toolbars are just like the other Office applications 

 

Home Toolbar : 

  
 

 Insert Toolbar : 

  
 Design Toolbar : 

  
 Animations Toolbar : 
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 Slide Show Toolbar : 

  
 Review Toolbar : 

  

  
 Developer Toolbar : 

  
 

 The most common choices for opening a presentation are:  

 New ‐ allows you to open a Blank presentation or you may choose from a  selection of Templates and 

Themes.  

 Open ‐ lets you navigate to an existing file to view and/or modify a presentation  that has already been 

created.  

 Recent – displays a list of your most recently created presentations and their file  locations.  

 

Title Bar 

This is the top section of the window. It shows the name of the file followed by the name of 

the program which in this case is Microsoft PowerPoint. 

 

Slide Area 

 This is the area where the actual slide is created and edited. You can add, edit and 

delete text, images, shapes and multimedia in this section. 

 

Help 

 The Help Icon can be used to get PowerPoint related help anytime you need.  

 Clicking on the "?" opens the PowerPoint Help window where you have a list of 

common topics to browse from. You can also search for specific topics from the 
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search bar at the top. 

 

 

 

Zoom Options 

 The zoom control lets you zoom in for a closer look at your text. 

 The zoom control consists of a slider that you can slide left or right to zoom in or out, 

you can click on the - and + buttons to increase or decrease the zoom factor.  

 The maximum zoom supported by PowerPoint is 400% and the 100% is indicated by 

the mark in the middle. 

 

Slide Views 

The group of four buttons located to the left of the Zoom control, near the bottom of the 

screen, lets you switch between PowerPoint views. 

 Normal Layout view: This displays page in normal view with the slide on the right and 

a list of thumbnails to the left. This view allows you to edit individual slides and also 
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rearrange them. 

 Slide Sorter view: This displays all the slides as a matrix. This view only allows you 

to rearrange the slides but not edit the contents of each slide. 

 Reading View: This view is like a slideshow with access to the Windows task bar in 

case you need to switch windows. However, like the slideshow you cannot edit 

anything in this view. 

 

Notes Section 

This sections allows you to add notes for the presentation. These notes will not be displayed 

on the screen during the presentation; these are just quick reference for the presenter. 

 

Quick Access Toolbar 

The Quick Access Toolbar is located just under the ribbon. This toolbar offers a convenient 

place to group the most commonly used commands in PowerPoint. You can customize this 

toolbar to suit your needs. 

 

Slide Tab 

This section is available only in the Normal view. It displays all the slides in sequence. You 

can add, delete and reorder slides from this section. 

 

 POWERPOINT BACK STAGE VIEW 

 

In Office 2010, Microsoft replaced the traditional file menu with the new Backstage view. 

This view not only offers all the menu items under the file menu, but additional details which 

makes management of your files a lot easier. 

 

 Accessing Backstage View  

You can access the Backstage view simply by clicking on the File tab. You can exit this view 

by clicking on any tab (including the File tab again). You can also press the 'Esc' button on 

the keyboard. 
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 Organization of Backstage View  

The backstage view has three sections or panes. 

 

 First Pane: This is the commands pane which consists of all the commands you would 

typically find in the file menu of older versions. You also have the Options menu which 

lets you edit the options on the program like customizing the ribbon. 

Various commands under the first pane are described in the table below: 

 

Command Description 

Save This allows you to save a new file or an existing file in 

standard format. If you are working on a previously saved file 

this will save the new changes in the same file format. If 
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you are working on a new file, this command would be similar to 

the Save As command. 

Save As Allows you to specify the file name and the file type before 

saving the file. 

Open Allows you to open new PowerPoint files. 

Close Allows you to close an existing file. 

Info Displays the information about the current file. 

Recent Lists series of recently viewed or edited PowerPoint files. 

New Allows you to create a new file using blank or pre-defined 

templates. 

Print Allows you to select the printer settings and print the 

presentation. 

Save & Send Allows you to share your presentation with larger audience via 

emails, web, cloud services, etc. 

Help Provides access to PowerPoint Help. 

Options Allows you to set various options related to PowerPoint 

program. 

Exit Closes the presentation and exits the program. 

 

 Second Pane: This is the subcommands pane. This will list all the commands related 

to the main command you choose in the first pane. For example, if you select Print in 

the first pane, you get to choose the printer and adjust the print settings in the second 

pane. 

 

 Third Pane: This is the preview or file information page. Depending on the 

command and the subcommand you select, this pane will either display the properties 

of the file or give you a preview of the file. 
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CREATING PRESENTATION 

 

PowerPoint offers a host of tools that will aid you in creating a presentation. These tools are 

organized logically into various ribbons in PowerPoint. The table below describes the various 

commands you can access from the different menus. 
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Menu Category Ribbon Commands 

Home Clipboard functions, manipulating slides, fonts, paragraph 

settings, drawing objects and editing functions 

Insert Insert tables, pictures, images, shapes, charts, special texts, 

multimedia and symbols 

Design Slide setup, slide orientation, presentation themes and 

background 

Transitions Commands related to slide transitions 

Animations Commands related to animation within the individual slides 

Slideshow Commands related to slideshow set up and previews 

Review Proofing content, language selection, comments and comparing 

presentations 

View Commands related to presentation views, Master slides, color 

settings and window arrangements 

 

Besides these depending on the objects selected in the slide, there are other menu tabs that get 

enabled. 

 

 

 ADDING NEW SLIDE 

 

In this chapter, we will understand how to add new slides in an existing presentation. Here are 

the steps that allow you to insert a new slide in the deck: 

 

Step 1: Right-click in the Navigation Pane under any existing slide and click on the New Slide 

option. 
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Step 2: The new slide is inserted. You can now change the layout of this slide to suit your 

design requirements. 

 

 

 

Step 3: To change the slide layout, right-click on the newly inserted slide and go to the 

Layout option where you can choose from the existing layout styles available to you. 
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 You can follow the same steps to insert a new slide in between existing slides or at the 

end on the slide list. 

 

 When we insert a new slide, it inherits the layout of its previous slide with one 

exception. If you are inserting a new slide after the first slide (Title slide), the 

subsequent slide will have the Title and Content layout. 

 

 You will also notice that if you right-click in the first step without selecting any slide 

the menu options you get are different, although you can insert a new slide from this 

menu too. 
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 ADDING TEXTBOX IN POWERPOINT 

 

 PowerPoint allows users to add text to the slide in a well-defined manner to ensure the 

content is well distributed and easy to read.  

 The procedure to add the text in a PowerPoint slide is always the same - just click in 

the text box and start typing.  

 The text will follow the default formatting set for the text box, although this 

formatting can be changed later as required. What changes is the different kinds of 

content boxes that support text in a PowerPoint slide. 

 

 Given below are some of the most common content blocks you will see in PowerPoint. 

 

 Title Box 

 This is typically found on slides with the title layout and in all the slides that have a 

title box in them. This box is indicated by "Click to add title". 
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Subtitle Box 

This is found only in slides with the Title layout. This is indicated by "Click to add 

subtitle". 

 

Content Box 

This is found in most of the slides that have a placeholder for adding content. This is 

indicated by "Click to add text". As you can see, this box allows you to add text as well as 

non-text content. To add text to such a box, click anywhere on the box, except on one of the 

content icons in the center and start typing. 
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Text Only Box 

This is not a default content box available in PowerPoint, but you can create it using Slide 

Master, if required. This is also indicated by "Click to add text". The only difference 

between the Text Only Box and the Content Box is that the former only supports text in the 

content area. 

 

 ADDING NEW TEXT BOX 

 

 

This chapter will teach you how to add new text boxes in a slide. Most of the standard layouts 

come with the text box option. As mentioned in the previous chapter, text boxes will have 

"Click to add text" as the default text. Here are the steps to add new text boxes in slide. 

Step 1: Click on the Text Box icon in the Home ribbon under the Drawing section. 
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Step 2: You will get the insert text box cursor that looks like an inverted cross. 

Step 3: Click to insert a text box. You can now start typing directly into the text box. 
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Step 4: Alternately, you can click and drag the cursor without releasing the click to 

create a text box. 
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The size of the text box can be adjusted by selecting one of the edges marked by squares or 

corners marked by circles. 

 

 Installed Templates & Themes 

 You can choose the installed templates and themes of Office for the new presentation  

 Installed Templates 
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 Slide Master 

  You will use the masters to make design changes that you want to appear on every slide:  

 PowerPoint presentations have two types of masters:  

◦ The Title Master contains objects that appear on the title slide.  

◦ The Slide Master contains objects that appear on all slides except the title slide.  

◦ If you want your company logo to appear on the bottom right of every page, you will add it to the Slide 

Master  

◦ If you want a picture of your office on a single slide, you add the picture to only that slide. 

Slide Master 
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You can choose the desired slide master from pane. 

 

DELETING EXISTING FILE 

There are times while building a slide deck, you may need to delete some slides. This can be 

done easily from PowerPoint. You can delete the slides from the Normal view as well as the 

Slide Sorter view. In each view, you can delete the slides in two ways. 

 

Deleting from Normal View 

Step 1: Go to the Normal view. 
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Step 2: Right-click on the slide to be deleted and select the Delete Slide option. 

 

Alternately, you can select the slide and press the Delete button on your key board. 
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Deleting from Slide Sorter View 

Let us now understand how to deleted slides from the Slide Sorter View. 

Step 1: Go to the Slide Sorter view. 
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Step 2: Right-click on the slide to be deleted and select the Delete Slide option. 

 

Alternately, you can select the slide and press the Delete button on your key board. 

 

 

 REARRANGING SLIDE 

 

Rearranging slides is important when it comes to organizing the overall presentation flow. 

While it is vital that you get the right content in every slide, it is equally important that you 

are able to present them in a format that makes it easier for the audience to understand the 

content too; most times this will require rearranging the slides. 

You can rearrange slides from two views in PowerPoint - Normal View and Slide Sorter 

View. Given below are the steps to rearrange slides from different views. 

 

 Normal View  

Step 1: Select the slide to be moved 

Step 2: Left click on the slide and drag it to the position in the sequence where you want to 

place it. PowerPoint will indicate the insert position with a line in-between existing slides. 
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Step 3: When you get to the right position release the left click button to insert the slide. 

Alternately you can also cut the selected slide and paste it back in the sequence as shown 

below. 

 

 



 

 

 

 Slide Sorter View  

Let us now understand how the Slide Sorter View works. 

Step 1: Select the slide to be moved. 

Step 2: Left click on the slide and drag it to the position in the sequence where you want to 

place it. PowerPoint will indicate the insert position with a line in-between existing slides. 

 

Step 3: When you get to the right position, release the left click button to insert the slide 

Alternately you can also cut the selected slide and paste it back in the sequence as shown 

below. 



 

 

 

 

 
 

 

 

 

WORKING WITH DIFFERENT VIEW 

 

 Normal view 

o Outline view 

o Slide view 

 Slide sorter view  

 Notes Page  

 Slide show  

You can acces the presentation view options from “View” 

 

 

 



 

 

 
 

 

Views: Normal View 

 The text outline of your presentation is in the left pane.   

 The current slide with all your graphics and objects is in the right pane.   

 Notes appear in the small pane below the Slide Pane. 

 
 

Inserting Footers and slide numbers 

You can insert Header&Footer and Slide Numbers from Insert toolbar  

 
All open the Header & Footer dialog box  which allows you to insert footer, date, and slide number 

 

Inserting Footers and slide numbers 

When you click on “Header & Footer” or “Slide Number” buttons, Header and Footer dialog box 

will be opened. 

 

Select to show Date and Time on the slide 



 

 

Select to show Date and Time on the slide 

 Indicates position of the slide number 

text box 

Select to show slide number on each slide 

 

Inserting Graphics 

 

 On the slide you wish to insert the graphics, from Home toolbar click on the little arrow next to “Layout”.  

 Click the content button of your choice in the content placeholder (clipart, file, etc.)  

 Locate the graphic you wish to insert, and click the OK button 

Inserting Graphics (clipart) 

 



 

 

 
 

Insert and resize pictures and clip-art images 

 

 PowerPoint comes with a gallery of clip art that you can insert into your presentations.  

 You can modify clip art by changing its size, grouping or ungrouping its components, changing some of its colors, 

or applying animation effects.  

 When you insert a picture or clip art, you might need to adjust the size of the object to fit your layout.  

◦ To do so, click on the resize handles that appear when the object is selected and drag in or out 

 

Insert a Chart in Your Presentation 

 In PowerPoint, click the Insert Chart icon in the placeholder that you want to contain the chart or on the Insert 

toolbar click Chart.  

 In the Insert Chart dialog box, click a chart, and then click OK.  

 



 

 

 

 
Create a Table 

 

 PowerPoint enables you to insert tables into slides in much the same way that you would insert tables into a Word 

document.  

 Tables are useful on slides when you want to arrange information horizontally in rows and vertically in columns. 

 To insert a table: 

◦ Change the layout to Title and Content and click on Table icon from the content part.  

◦ Define the number of columns and rows 

◦ Add information to the table 

 

A SLIDE WITH A TABLE 



 

 

 
 

Inserting Transitions 

 
 

Slide Transitions 

 

To Apply a Transition to One Slide: 

• Select the slide you wish to modify. 

• By default, No Transition is applied to each slide.  

• Click the More drop-down arrow to display all the transition effects.  

• Click a slide transition effect to apply it to the selected slide. 

• Click Apply To All to apply the transition to all the slides in the presentation. 

 

 



 

 

 
 

Saving your presentation 

 

 Save your presentation by Clicking Office Button and then Save As.  



 

 

 
 

Print your Presentation 

 

 Select File->PRINT 

 For Printer,Select the printer you want to print to 

 For Settings,Select the options you want slides: 

 From drop-down, choose to print all slides,selected slides or current slide. 

 For Copies Select how many copies you want to print. 

 Select print. 

 Print All Slides prints out the entire presentation, one slide per page, usually  landscape.  

 

Printing A Presentation 
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